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1 Overview 
The main objective behind the Dominion Member Services (DMS) web site is to offer its 
members benefits and incentives that will build customer loyalty and leave members 
feeling good about using Dominion Services. 

One of the ways that Dominion is going to achieve this is by forming relationships with 
vendor partners and making exclusive offers of discounted prices or other deals for items 
offered on the DMS site. Members will have access to shopping for products from the 
Member Benefits page of the DMS web site. 

The DMS site eventually will have all of the capabilities of a typical e-commerce website 
where customers are able to browse for products that interest them, place products into a 
virtual shopping cart without actually purchasing them, and complete the purchase online 
at a future time, if they wish to do so. Dominion will be taking care of fulfillment for some 
of the products offered, and in other cases will transfer the member over to a partner site 
and have the partner take care of fulfillment. 

Each partner will have a separate part of the site fronted by a “billboard” page that 
identifies the partner and the products they offer, effectively giving each partner a sub-
site within the DMS site. Each partner area contains the offers from that partner, divided 
into categories and sub categories. 

Initially, there is only one partner. Lowe’s Home Improvement Warehouse is offering 
exclusive rebates on a selection of washers, dryers, ranges, and refrigerators to DMS 
Members. Members will be able to view descriptions of the appliances covered by the 
rebates, and print out a rebate form. After they purchase the appliance at Lowe’s they 
can send in the form with their receipt and receive the rebate. 

Each member has a Member ID so that the site can identify them and handle all 
purchases through the correct member account. Member accounts will be protected by a 
password to assure that a member’s private information remains private. Members can 
identify themselves each time they visit the site, or choose to have their login information 
“remembered” by their computer. 

In addition to the member services available on the site, Members can view help for using 
DMS, modify their account information, access information about the site, and leave a 
message for Customer Service. If the documents on the site are not enough to help a 
Member to use the site successfully, help is only a phone call away through Dominion’s 
Customer Care Representatives (CCRs). 

This document will describe the most common tasks associated with the Dominion 
Member Services site, and give step-by-step instructions on performing those tasks. In 
addition to tasks that Members will be performing, this document also contains 
instructions for tasks that CCRs may need to perform to help Members access the site. 
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2 Member Tasks 
Members are responsible for finding access to the Internet and starting up their web 
browser to point to the DMS site. The Uniform Resource Locator (URL) for the DMS site 
is: 

http://www.dms.dom.com/ 

Once Members reach the site, the first thing they will see is a “Splash Screen”. This 
screen welcomes them to the site. 

 
The DMS “Splash Screen” 

After about ten seconds, the splash screen is replaced by the login screen. (If this doesn’t 
happen automatically, Member’s can select the “Continue” link.) This first thing Members 
need to do is log into their account. After they’ve logged in, they can begin navigating the 
site to access Member Benefits, access and modify their account information, and access 
the Customer Service portion of the site. When they are finished with the site, Members 
should log out to keep others from using their account. 
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2.1 Logging In 
The log in process may differ depending on whether or not the Member has visited the 
site before. Even if they’ve visited before, the process will differ based on whether or not 
they asked the site to remember them, and whether or not they remember their 
password. 

Once a Member directs their browser to the DMS site, the DMS Login Page will display in 
the browser window. 

 
DMS Login Page 

The Login page contains the following components: 
• Some welcome text 
• “Member ID” text box 
• “Password” text box 
• “Remember Me” checkbox 
• “Login” button 
• “Help” button 
• Customer Service phone number 
• Link to the “Terms and Conditions” of using the DMS site. 
• Link to the DMS site’s “Privacy Policy”. 



Using the DMS Site Dominion Retail Inc. Confidential 

Proprietary to Dominion Retail Inc. 05/24/2001  7 

2.1.1 For the first time 

If a Member is logging in for the first time, they will need to enter their Member ID and 
password, and then proceed through some preliminary registration steps. 

A Member’s ID and original password will be sent to them in a letter from Dominion. If the 
Member does not have that letter handy, a CCR can assist them by looking that customer 
up in the Member database using the administrative tools. See “



Using the DMS Site Dominion Retail Inc. Confidential 

Proprietary to Dominion Retail Inc. 05/24/2001  8 

Looking up a member’s account information” on page 28 for more information on that 
topic. 

Once the customer has the Member ID and Password, they should: 

1. Select (click in) the “Member ID” text box, and type their Member ID. The Member 
should make sure to type in their ID using the same combination of upper and lower 
case that is used on the letter. 

2. Select (click in) the “Password” text box, and type their Password. The Member 
should make sure to type in their password using the same combination of upper and 
lower case that is used on the letter. 

3. If the Member would like their Member ID to be remembered, they should select the 
checkbox labeled “Remember Me”. Note: Checking this box will only remember them 
on the computer they are currently using. If they later use a different computer, they 
will need to remember their Member ID. 

4. Select (click) the “Login” button to proceed. The browser displays a welcome screen, 
which will show the Member’s name near the top. 

 
Welcome Screen for first time visitors 

New components on this page: 
• “Home” and “Logout” links in the upper right of the page 
• “Reminder Question” drop-down menu 
• “Reminder Answer” text box 
• “Email Address” text box 
• “Submit” button 

The Member should: 

5. Choose a question from the “Reminder Question” drop-down menu. The member 
should pick the one that others are least likely to guess the correct answer to. 

6. Select (click in) the “Reminder Answer” text box and type in the answer to the 
selected question. 

7. If the Member would like to provide their email address to the system, they should 
select the “Email Address” text box and type in their email address. 

8. Select the “Submit” button. 
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The member is now logged into the site. The web browser displays the DMS “home” 
page, which is described on page 13. 

2.1.2 For “remembered” members 

If the member checked “Remember Me” when they last logged into the site, they will not 
need to remember their Member ID the next time they use that computer. After directing 
their browser to the site, their login page will be personalized, and they will only need to 
type their password to log in. 

 
Login page for remembered members 

To log in, a remembered member should: 

1. Select (click in) the “Password” text box, and type their Password. The Member 
should make sure to type in their password using the same combination of upper and 
lower case that is used on the letter. 

2. If the Member would like their Member ID to no longer be remembered, they should 
select the checkbox labeled “Remember Me”, which will un-check the box. 

3. Select (click) the “Login” button to proceed. The browser displays a welcome screen, 
which will show the Member’s name near the top. 
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2.1.3 For a returning Member 

Members who have visited the site before, but who did not ask to be remembered, must 
enter the site through the log in page. 

 
General Login Page 

1. Select (click in) the “Member ID” text box, and type their Member ID. The Member 
should make sure to type in their ID using the same combination of upper and lower 
case that is used on the letter. 

2. Select (click in) the “Password” text box, and type their Password. The Member 
should make sure to type in their password using the same combination of upper and 
lower case that is used on the letter. 

3. If the Member would like their Member ID to be remembered, they should select the 
checkbox labeled “Remember Me”. Note: Checking this box will only remember them 
on the computer they are currently using. If they later use a different computer, they 
will need to remember their Member ID and password. 

4. Select (click) the “Login” button to proceed. The browser displays a welcome screen, 
which will show the Member’s name near the top. 
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2.1.4 If you’ve forgotten your password 

Since it’s a bad idea to write down your password anywhere, it’s easy to lose track of 
passwords, particularly if you don’t visit a site every day. The DMS site has features built 
in to aid Member’s who have forgotten their password. 

Members will still need their Member ID to access the site, but they can use the reminder 
question to access the site and change their password if they can’t remember it. If a 
Member cannot recall their Member ID, they will need to call the Customer Service line 
and have a CCR look them up in the system. See “
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Looking up a member’s account information” on page 28 for more information on that 
topic. 

To log into the site without their password, Members should first direct their browser to 
the DMS site. From the General Login page, and then: 

1. Enter their Member ID in the “Member ID” text box. 

2. Select (click on) “Forgot Your Password?”. The browser displays the following page: 

 
Password Reminder page 

3. The reminder question the Member selected is displayed. Enter the answer in the 
text box immediately below the question. 

4. The system will change the Member’s password to a generated password. To have 
this password emailed, the Member must enter a valid email address in the next text 
box. If they entered an email address when they set up their account, it will already 
be in the text box. 

5. If they enter a new address, and want it added to their Member profile, they should 
check the check box next to “Save email address”. 

6. Select “Submit”. 

The Member is now logged in just as if they’d remembered their password. If they don’t 
want to keep the password that is generated for them, they can change their password as 
described in “Changing your Password” on page 17. 
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2.2 Navigating the Site 
The “home” page for the DMS site looks like this: 

 
DMS Home page 

There are three links in the upper right-hand corner of the page. These links are available 
on most of the pages in the site. 
• Home – will always bring Members back to this home page. 
• Logout – will log the Member out of the DMS site, securing their account from others 

who may use their computer. 
• Site Index – will take Members to a “site map” that lists the major areas of the site so 

Members can find them quickly. 

The links in the body area of the page lead Members to the major sections of the DMS 
site. 
• Member Benefits – will take Members into the area of the site that contains the 

special offers available to them. 
• My Account – will take Members into the area where they can make change to their 

Member Profile, such as changing their mailing address, Member ID, or password. 
• Customer Service – will take Members into an area that contains information about 

the site, and some help on using the site. There is also a form for sending a message 
directly to Customer Service. 

Select (click on) a link to enter that section of the site. Members can also access each of 
these sections by selecting the tab with its name that is on most pages of the site. 

At the bottom of the home page is the customer service phone number, just in case 
Members ever need to talk to a Customer Care Representative, a link to the “Terms and 
Conditions” for using the DMS site, and a link to the site’s “Privacy Policy”. 
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2.3 Shopping 
The main purpose of the site is to enable Members to shop for merchandise or other 
special offers that Dominion is making available through its partners. Members 
accomplish this through the “Member Benefits” part of the site. They can get to this area 
through the home page, site index, or a tab. The main page of this area currently looks 
like this, but it may change. 

 
Main Member Benefits page 

Notice the tabs at the top of the body area. Members can use them to directly access any 
of the three main sections of the site without having to go back to the home page. 

To begin shopping, Members should: 

1. Choose a partner by selecting its logo from the logos that are shown. This displays 
the “billboard page”: for that partner. 

 
Lowe’s Billboard page 

Each partner’s billboard page will be different, depending on what that partner has to 
offer. The following steps are specific to Lowe’s, and are only meant to give you an idea 
of the general shopping experience. 
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2. If more than one offer is available for that partner, Members need to select one of the 
offers available from that partner. This will take them to a display of the details for 
that offer, or subcategories within that offer. 

For instance, if they selected “Refrigerators” from the Lowes billboard page, 
information about the different refrigerators covered by this offer is displayed. 

 
Refrigerators category page 

They may also have the option of choosing further subcategories. This will depend on 
the exact nature of the offers available from that partner. 

3. Once they have decided to take advantage of an offer, they should follow the 
instructions on the offer page that detail how to do so. 

They may be able to purchase discounted merchandise directly from the site after 
entering their credit card number. They may need to print a rebate form and mail it in 
after completing their purchase at a retailer. 

When they’re finished with the site, Members should not forget to log out, by selecting the 
“Logout” link in the upper right-hand corner of the page. This will log them out of the site. 

 
You are now logged out 

Logging out of the site will secure their account and personal information from others who 
may use this computer. 
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2.4 Accessing and changing your account information 
The main route to Members’ account information is through the “My Account” section of 
the DMS web site. Selecting “My Account” from the DMS home page or from a tab will 
display the following page: 

 
“My Account” page 

In addition to the standard links available on this page, there are three links specifically 
for accessing and changing aspects of the Member’s account. 
• My Profile – accesses personal information like name and phone number, as well as 

the reminder question for logging in if the password is forgotten. 
• My Password & ID – accesses Member ID and Password information. 
• Mailing Info – accesses the mailing address(es) used by the DMS site for shipping 

online purchases. 

Members can use these pages to simply access this information, or to change the 
information. All viewing and modification takes place over a secure connection to protect 
the Member’s personal information against interception in the network. 

2.4.1 Accessing your account information 

Accessing account information is simple. After logging into the DMS site and choosing 
“My Account” from the home page: 
• Select the link that describes the information they would like to accesses. The 

information displays in the browser window. 

Current information is printed in text boxes. When the Member is finished viewing that 
information, the Member should do one of the following: 
• Select a navigational link to the left of the information to view a different set of 

information. 
• Select one of the tabs above the information to exit the “My Account” section and 

switch to a different part of the web site. 
• Select the “Home” link at the top of the page to return to the DMS home page. 
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2.4.2 Changing your Password or Member ID 

First, access the “My Account” section of the web site, and select “My Password & ID”. 
The following page displays in the web browser: 

 
“My Password & ID” page 

The Member’s current Member ID is shown. If the Member wants to change their 
Member ID, they need to: 

1. Select the “New Member ID” text box. 

2. Enter a different Member ID. 

3. Select the “Submit” button. 

4. If the Member ID they’ve selected is being used by another Member, a list of 
alternatives is displayed. 

 
Suggestions for New Member ID 

If the Member would like to use one of those IDs instead, they should: 
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a. Select the round “radio button” next to the choice they like. 
b. Select the “Accept” button. They will be returned to the “My Password & ID” 

page, and their choice will already be entered in the “New Member ID” text box. 
c. Select the “Submit” button again. 

If the Member does not wish to use any of the provided choices, they should select 
the “Decline” button. 

This will be their new Member ID, and they will need to remember this new ID the next 
time they come to visit the DMS site. Their old Member ID will no longer work. If they also 
want to change their Password, they should continue. 

If the Member wants to change their password, they need to: 

1. Select the “Old Password” text box. 

2. Type their current password in the text box. 

3. Select the “New Password” text box. 

4. Type a new password in the text box. It will not display in letters, but with an asterisk 
for each letter. This is to prevent anybody reading the password over the Member’s 
shoulder. 

5. Select the “Confirm New Password” text box. 

6. Type in the same password again. Since the password does not display as the 
member types, the site requires the Member to type the same password twice to 
guard against typing errors. 

7. Select the “Submit” button. 

Once they select “Submit”, the Member’s old password will no longer work. The site will 
require their new password the next time they visit. 
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2.4.3 Changing your Mailing Information 

First, access the “My Account” section of the web site, and select “Mailing Info”. The 
following page displays in the web browser: 

 
“Mailing Information” page 

Initially, this mailing information will match the information associated with the Member’s 
Dominion customer account. Members can change this information to any address they 
like. To change this information, the Member should: 

1. Select the text box next to the label that identifies the information they want to 
change. 

2. Remove the current contents of the text box with the “Delete” and “Backspace” keys 
of the keyboard. (Text boxes that are marked with an asterisk are required, and 
cannot be left blank.) 

3. Enter new information. 

4. For drop-down menus, select the button at the right edge of the menu, and pick a 
new choice from the list. 

5. Select the “Submit” button to change the information. If the Member changes some 
items, but does not wish to submit those changes, use the “Refresh” command of 
their web browser to clear all changes. 

This information only applies to online purchase made through the DMS web site. 
Changes made on this page will not affect any other accounts the Member may have 
with Dominion, including gas or electrical consumer accounts. 
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2.4.4 Changing your Member profile 

First, access the “My Account” section of the web site, and select “My Profile”. The 
following page displays in the web browser: 

 
“My Profile” page 

Initially, this information will match the information associated with the Member’s 
Dominion customer account, and the information the Member enters the first time they 
log into their DMS account. To change this information, the Member should: 

1. Select the text box next to the label that identifies the information they want to 
change. 

2. Remove the current contents of the text box with the “Delete” and “Backspace” keys 
of the keyboard. (Text boxes that are marked with an asterisk are required, and 
cannot be left blank.) 

3. Enter new information. 

4. For drop-down menus, select the button at the right edge of the menu, and pick a 
new choice from the list. 

5. Select the “Submit” button to change the information. If the Member changes some 
items, but does not wish to submit those changes, use the “Refresh” command of 
their web browser to clear all changes. 

The “User Verification Question” is the reminder question used to identify the Member if 
they forget their password. If the Member wants to select a new question or change their 
answer 

1. Select the button at the right end of the “Reminder Question” drop-down menu. 

2. Choose a reminder question from the list. Members should use a reminder question 
that others are not likely to guess their answer to. 
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3. Select (click in) the “Reminder Answer” text box. 

4. Type in the answer to the question. 

5. Select the “Submit” button to change the information. If the Member changes some 
items, but does not wish to submit those changes, use the “Refresh” command of 
their web browser to clear all changes. 

2.5 Accessing Customer Service 
To access the customer service portion of the DMS web site, Members should select 
“Customer Service” from the DMS home page or from a tab. The main customer service 
page looks like this: 

 
“Customer Service” page 

The following links are available on this page: 
• Contact Us – takes Members to a page where they can send email to DMS without 

leaving their browser window. 
• FAQs – displays a list of frequently asked questions, and their answers. 
• Site Index – will take Members to a “site map” that lists the major areas of the site so 

that they can find them quickly. 
• Terms and Conditions – displays a document outlining the terms and conditions for 

using the Dominion Member Services web site. 
• Privacy Policy – displays a document that details DMS’s policy to protect the privacy 

of its Members. 
• Help – displays some help on common DMS tasks. 
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2.5.1 Contacting Customer Service 

Members can always call the customer service telephone number, send postal mail, or 
send email directly to DMS Customer Service. If they would like, they can also send 
email through the DMS site itself, so that they do not need to start a separate program.  

 
“Contact Us” page 

From the “Customer Service” page, Members should select the “Contact Us” link. The 
“Contact Us” page details the methods available for Members to contact Customer 
Service. If the Member wants to send email directly from this page, they should: 

1. Choose a category from the drop-down menu. This will enable the system to route 
the message to the most appropriate representative. 

2. Select the text area, and type in their message. They do not need to hit return at the 
end of each line; the text will wrap automatically to fit the text area. If their message 
gets too long to fit in the area, the scroll bar will activate, enabling them to scroll back 
to earlier parts of their message. 

3. Select (yes or no) whether or not they would like to receive an email response to their 
message. If they choose “no”, they will not receive a response of any kind. 

4. If they choose “yes”, they will need to enter an email address. Customer service will 
send the response to this address, so the Member should make sure it is a valid 
address. 

5. Select “Submit” to send their message. The site will display a “Thank You” page. 
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Thank you for your comment, suggestion, or question 

6. Select “Continue”, which will return them to the DMS home page. 
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2.5.2 Using the Site Index 

The Site Index provides an easy way to access most of the pages in the DMS site without 
having to browse through multiple levels. It is particularly handy if a Member wishes to 
return to a page they viewed during a previous visit, but cannot remember how they 
reached. 

 
Site Index 

The list directly beneath the title shows the main sections of the Site Index. Members can 
select any entry in this list to jump directly to that section of the index without having to 
use the scroll bar. To return to the top of the page, Members can select the “Back to top” 
links at the bottom of each section. 

Selecting any of the entries in the index takes the Member directly to the listed page. To 
return to the Index, Members can use the “Site Index” link at the top of each page, or use 
their browser’s “Back” button. 
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2.6 Turning on “Cookies” 
A cookie is a tiny piece of text asking permission to be placed on your computer's hard 
drive. If you agree, then your browser adds the text in a small file. DMS requires 
Members to accept cookies. 

If the Member is running AOL, they will need to launch their browser independently of 
AOL. After changing the browser settings, they will need to close and re-open their 
browser before the changes will take effect. Once the browser is started, depending on 
which browser they are running, they should: 

2.6.1 Internet Explorer 4.0 and AOL  
1. Go to the “View” menu and choose “Internet Options”. 

2. Select (click on) the Advanced tab.  

3. Scroll down to the section titled “Cookies”. 

4. Select the button to “Prompt before accepting cookies”, 
OR 
Select the button to “Always accept cookies”. 

2.6.2 Internet Explorer 5.0  
1. Go to the “Tools” menu and choose “Internet Options”. 

2. Select the “Security” tab. 

3. Select “Internet” in the “Web content zone” list. 

4. Select the “Custom Level” button. 

5. Scroll down to the section titled “Cookies”. 

6. Select “prompt” or “enable” for the cookie options that read “Allow cookies that are 
stored on your computer” and “Allow per-session cookies”. 

2.6.3 Netscape Navigator 4.x  
1. Go to the “Edit” menu and choose “Preferences”. 

2. Go to the small window on the left side of the dialog box and select “Advanced”. 

3. In the section titled “Cookies”, choose “Accept all cookies”. 

4. If the Member would like a warning before accepting a cookie, they should check the 
box titled “Warn me before accepting cookies”. 

2.6.4 Netscape Navigator 6.x  
1. Go to the “Edit” menu and choose “Preferences”. 

2. Go to the small window on the left side of the dialog box and select “Advanced”. 

3. In the section titled “Cookies”, choose “Enable all cookies”. 
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2.7 Logging Out 
Members should always log out when they are finished using the Dominion Member 
Services web site. Logging out will protect the Member’s personal information from other 
people who may use the same computer. 

The “Logout” link is always available in the upper right-hand corner of every page on the 
DMS site. 

 
“Logout” link 

To log out of the site at any time, Members should: 
• Select (click on) this link. 

This logs the member out immediately, and displays this page in their browser window: 

 
Thank you for visiting 

If the Member logged out accidentally, they can select the “Login” button to return to the 
login page of the site and re-enter their Member ID and Password. 
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3 Customer Care Tasks 
Not every task can be performed by Members through their own accounts. Some tasks 
can only be performed by Customer Care Representatives (CCRs) through the DMS 
Administration server. The Uniform Resource Locator (URL) for the DMS administration 
site is: 

http://admin.dms.dom.com/ 

This separate web site contains the tools that CCRs use to perform those administrative 
tasks. 

3.1 Logging in to the DMS Administration site 
Before you can perform any administrative functions, you must first log into your 
administrative account. 

1. Direct your browser to the DMS Administration site. 

2. Enter your DMS Administration ID and password 

3. Select “Login” 

Lists of “Customer Service” and “Marketing” functions display in the browser. 

 
DMS Administration home page 
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3.2 Looking up a member’s account information 
The first step in performing any administrative tasks on a Member’s account is to find 
their account record in the system. You can also use this function to look up information 
for a Member, for instance their Member ID. 

From the DMS Administration home page: 

1. Select “Look Up Member / Create a New Password” from the list of Customer Service 
functions. The “Search for Member” page displays. 

 
Search for Member 

2. Enter as much information as the Member is willing or able to supply. You need at 
least a last name to start. If the Member can supply their Member ID or phone 
number, that will narrow the search down to a single record. You may make partial 
entries into some boxes. For instance, if a Member is not willing to supply their whole 
phone number, you can enter just the last four digits, or if their last name is very long, 
you can enter just the first eight letters. 

3. Select “Submit”. The system looks through the database, and if it finds more than one 
match, returns a page of search results. (If it only finds one match, it will jump directly 
to the “Change Information” page, and you can skip to the instructions for that step.) 

 
Select a Member ID from result list 
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4. If there is more than one record listed, ask the Member for any information that could 
narrow the list down, for instance middle initial, zip code, or phone number. 
OR 
If too many records are listed, select the “Back” button to return to the “Search for 
Member” page, and try the search again with more information. 
OR 
If no records are listed, select the “Back” button to return to the “Search for Member” 
page, and try the search again with less information. 

5. To access more information about a Member, select that Member ID from the list of 
results. The “Change Information” page will display in your browser. 

 
Change Information 

From here, you can edit some portions of a Member’s record, including creating a 
new password. 

6. Before reading out any information or proceeding to change information, verify the 
Member’s identity using the “Reminder Question”. Ask the Member the reminder 
question (if one is assigned), and do not proceed unless the Member responds with 
the correct answer. 

When you are finished, don’t forget to log out of the DMS Administration site by selecting 
the “Log Out” link in the upper right-hand corner of the page. To start over without logging 
out, select the “Home” link. 
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3.3 Changing a member’s password 
From the “Change Information” page of the DMS Administration web site, you can 
change some aspects of a Member’s account for them. The most important is creating a 
new password for them if they forget their password. 

 
Change Information 

1. First, confirm that you have the correct record, and verify the identity of the Member 
using the “Reminder Question”. Ask the Member the reminder question (if one is 
assigned), and do not proceed unless the Member responds with the correct 
answer. 

2. Ask the Member if they would like to have the new password emailed to them. 

3. If they would, confirm the email address shown in the text box labeled “Email 
Address”. 

4. If this address is not correct, or if the Member has not previously supplied an email 
address to DMS, request a new address and enter it in the text box. 

5. If you entered a new address, ask the Member if they would like to have this email 
address saved to their account. 

6. If they would, check the checkbox next to the “Email Address” text box. 

7. The Member’s new password is shown at the bottom of the page. You can read this 
new password out to them if they would like. 

8. To create the new password and mail it to the Member, select the “Submit” button at 
the bottom of the page. 

9. Encourage the Member to log in as soon as possible and change their password to 
something that is easier to remember. 

When you are finished, don’t forget to log out of the DMS Administration site by selecting 
the “Log Out” link in the upper right-hand corner of the page. To start over without logging 
out, select the “Home” link. 
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4 Error Pages 
Of course, the people responsible for building the Dominion Member Services site have 
tried to build the best site they can, and have tried to design the site so that Members will 
have as little trouble as possible accessing the site. However, sometimes the unfortunate 
does happen, and a Member may encounter an error.  

The DMS site tries to handle these errors as gracefully as possible, and provide 
Members with a way to proceed past the error without needing technical knowledge. 

4.1 “Oops!” page 
This page informs the member that their browser is not configured properly to take 
advantage of all of the features of the DMS site. After the generic message, a more 
detailed description of the problem explains the issue, and what steps the Member may 
wish to take. 

 
“Oops!” page 

Most frequently, this error page is displayed because the Member has configured their 
browser to not accept “cookies”. The Member must reconfigure their browser to accept 
cookies. 

For more information about enabling cookies in the browser, see the DMS site’s “Help” 
page, or see “Turning on “Cookies”” on page 25. 

If a Member sees this screen they should: 

1. Consider enabling cookies in their browser. 

2. Select the “Help” button if they need more information about enabling cookies. 



Using the DMS Site Dominion Retail Inc. Confidential 

Proprietary to Dominion Retail Inc. 05/24/2001  32 

4.2 Server Error page 
This page informs the member that there has been an error of some kind on the web 
server. The large statement at the top of the body portion of the page gives a brief 
statement of the error, followed by more detail. In addition to displaying this page, the 
web server also automatically sends a message to the server maintainers that describes 
the error in detail.  

 
Configuration Error page 

In most cases, the Member has not done anything wrong, and there is nothing they 
should do as a remedy. Unfortunately, the site is not able to continue past an error of this 
kind. The Member should select the “Home” button, which will return them to the DMS 
Home page where they can start over. 
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